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Abstract 

 

Mobile Laser Scanning is an effective method for collecting high-resolution spatial data. The assessment of the geometric accuracy of 

the point clouds remains a key topic in land surveying. This paper focuses on the evaluation of the internal geometric accuracy and 

measurement repeatability of data acquired by the RIEGL VMX-2HA mobile laser scanning system. The objective of the research is 

to assess the system’s ability to generate spatially consistent outputs under identical input conditions. It is important to identify and 

quantify the influence of selected environmental variables such as the condition of the road surface, current meteorological conditions 

and time of day during data collection. The experimental part was conducted in the form of ten individual test runs along an identical 

route in an urban area in the city of Prague, the Czech Republic. Each test run was conducted under various scenarios – on dry and wet 

surfaces, at different hours of the day (morning, midday and evening hours), and under variable weather conditions. A combination of 

spatial statistics and point cloud comparison techniques was used to evaluate repeatability, focusing on the road surface. The results 

show that the RIEGL VMX-2HA mobile laser scanning system has a high level of internal accuracy under standard conditions. Specific 

environmental conditions may cause a slight increase in measurement uncertainty (e.g., a wet road surface). The observed deviations 

remain within the tolerance limits defined for standard engineering and land surveying applications. 

 

 

1. Introduction 

 

Mobile laser scanning (MLS) represents a modern technology for 

the rapid and highly detailed acquisition of spatial data in a wide 

range of environments. By integrating a laser sensor, an inertial 

measurement unit (IMU), and geodetic GNSS satellite systems 

receiver(s), it is possible to generate a point cloud with density 

and accuracy at the centimetre to millimetre level, at scanning 

rates ranging from several hundred thousand up to millions of 

points per second.  

 

In addition to the accuracy of control point determination, a key 

parameter in evaluating the quality of MLS is the internal 

accuracy of the system, referred to as repeatability, which 

describes the consistency and stability of measurements within a 

single dataset, regardless of its absolute georeferencing. In other 

words, it indicates the extent to which similar results can be 

obtained when the same data acquisition and processing 

procedure is applied. 

 

In current geodetic practice, various MLS are employed, ranging 

from SLAM scanners carried by an operator or, for example, 

mounted on a drone, to lidar systems primarily designed for 

airborne platforms. The objective of this experiment is to verify 

the internal accuracy of the car-mounted mobile mapping system 

Riegl VMX-2HA through a practical test, which includes the 

measurement of reference control points, subsequent data 

acquisition (10 datasets), and their evaluation. 

 

 

 
* Corresponding author 

2. Riegl VMX-2HA Mobile Unit 

For the testing, the Riegl VMX-2HA mobile unit was used. The 

unit integrates a pair of Riegl VUX-1HA laser scanners, an 

inertial measurement unit (IMU), and a multi-frequency GNSS 

receiver. This configuration enables precise determination of 

position and orientation during motion, thereby ensuring the 

georeferencing of the resulting point cloud. 

 

 
 

Figure 1. Riegl VMX-2HA system 

 

Main technical parameters of the Riegl VMX-2HA: 

• Number of scanners: 2 × VUX-1HA 

• Maximum data acquisition rate: up to 2,000,000 points/s 

• Maximum range: 420 m 

• Measurement accuracy: 5 mm (standard deviation). 

 

 

3. Determining Control Points 

For the purpose of establishing a reference framework and the 

subsequent transformation of the point cloud into the S-JTSK 

coordinate system, control points were determined. A total of 8 
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control points were established and distributed to provide 

uniform coverage of the surveyed area. 

 

 
 

Figure 2. Riegl VMX-2HA mounted on Škoda Yeti 2.0 TDi 

81kW 4x4 

 

All points were stabilized in the field by applying a white spray-

painted checkerboard target (square side of 0.2 m), see Figure 3, 

and were marked to allow for inspection and repeated 

measurement. 

 

 
 

Figure 3. Control point detail 

 

The process of determining the control points was carried out in 

two stages: 

 

3.1 GNSS Measurement Using the RTK Method 

The control points were first determined using GNSS technology 

in RTK mode. These measurements provided approximate 

coordinates, which subsequently served as the initial adjustment. 

The measurements were performed twice on 23rd May 2025 

(with a two-hour interval). 

 

3.2 Measurement of the Spatial Network with a Total 

Station 

To achieve higher accuracy, the points were surveyed using a 

Leica MS50 total station. The measurements were carried out 

from three free stations in two faces of the telescope. To increase 

the rigidity and stability of the spatial network, four auxiliary 

points were also established. The adjustment was performed in 

EasyNet software. A total of 66 observations were made, with 5 

outliers excluded (2 × zenith angle, 3 × slope distance). After 

removing the outliers, 17 redundant observations remained. The 

final coordinates (X, Y, Z), including the achieved standard 

deviations (sX, sY, sZ), are presented in the following table. Points 

101-104 represent the auxiliary points, while points 1001-1004 

are the ground control points used for later point cloud 

adjustment and georeferencing. A graphical representation is 

provided in Figure 4. 

 

Point 

ID 
Y[m] X[m] Z[m] 

sY 

[mm] 

sX 

[mm] 

sZ 

[mm] 

101 734705,900 1048313,120 271,510 1,4 0,8 0,3 

102 734688,402 1048303,257 271,141 1,1 0,8 0,3 

103 734749,393 1048185,045 264,427 1,4 0,5 0,4 

104 734732,641 1048180,086 264,295 0,9 0,9 0,4 

1001 734754,729 1048107,521 259,737 2,2 1,0 0,6 

1002 734743,503 1048107,302 259,740 2,1 1,0 0,6 

1003 734711,722 1048245,640 268,290 1,1 0,8 0,3 

1004 734722,075 1048248,043 268,233 1,2 0,6 1,0 

1005 734694,209 1048341,142 272,942 1,1 1,1 0,3 

1006 734681,064 1048337,929 273,071 1,4 0,6 0,3 

1007 734698,228 1048429,308 276,849 2,0 1,2 0,6 

1008 734706,976 1048424,180 276,743 2,0 1,2 0,6 

9501 734673,289 1048361,159 275,897 0,9 0,5 0,3 

9502 734717,710 1048271,166 270,851 0,8 0,6 0,2 

9503 734752,531 1048170,024 265,425 0,9 0,4 0,3 

Table 1.  Result control points coordinates with achieved 

accuracies. 

 

 
 

Figure 3. Observation plan 

 

 

4. Data Acquisition Procedure 

Data acquisition was conducted on a test section 350 meters in 

length (with overall recording distance 550 meters, 

approximately 70 meters before and after the control points) in 

an urban environment, featuring an elevation change of 26 meters 

and two curves. This setup allows the simulation of real 

operational conditions with varying geometry and terrain height. 

A total of ten passes were performed on different days and at 

different times of day, six under dry conditions and four under 

wet conditions, to account for the influence of weather on GNSS 

and laser scanning quality. Vehicle speed did not exceed 50 km/h, 

with several stops at different locations during various passes due 

to pedestrians and other common obstacles. Detailed weather 

conditions are presented in the table 2. 

The test section was scanned during each of the ten passes using 

the Riegl VMX-2HA mobile scanning system, with data 

acquisition controlled directly from the vehicle via the control 

unit. The scanning system was operated using RiACQUIRE MLS 
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software, which ensures synchronized recording of laser 

measurements and GNSS/IMU data during motion. Prior to data 

acquisition, a static alignment was performed, during which the 

IMU is calibrated, and the system is synchronized with the 

reference framework. 

 

Pass 

no. 
Date Time Weather 

Surface 

Status 

Temperature 

°C 

1  4.4.2025 14:30 Sunny Dry 18 

2  9.4.2025 7:00 Cloudy Dry 3 

3  9.4.2025 15:00 Cloudy Dry 10 

4 23.04.2025 7:00 
Mostly 

Sunny 
Dry 7 

5 23.04.2025 14:00 
Mostly 

Sunny 
Dry 19 

6  2.6.2025 9:00 Cloudy Wet 12 

7 16.06.2025 11:00 Cloudy Wet 16 

8 14.07.2025 12:30 
Mostly 

Sunny 
Dry 28 

9 14.07.2025 14:45 Cloudy Wet 27 

10 14.07.2025 15:15 Cloudy 
Semi-

wet 
27 

Table 2.  Weather conditions of respective passes 

 

This was followed by the dynamic initialization phase, during 

which the vehicle traverses a calibration section at varying speeds 

and performs simulated manoeuvres (“weaving”). During the 

pass through the area of interest, the trajectory is continuously 

recorded using the integrated GNSS system. After completing the 

scanning, a dynamic alignment is first performed again, followed 

by a static alignment. 

 

 
 

Figure 5. Data collection pass scheme 

 

5. Data Computing Procedure 

After downloading the acquired data from the control unit disks, 

the point cloud was subsequently processed in the office: 

 

1. Trajectory refinement was performed in POSPac MLS 

software, where GNSS and IMU data are integrated to 

achieve maximum positional accuracy. GNSS 

reference station data were used to support the 

trajectory refinement. 

 

2. Based on the refined trajectory, individual points of the 

point cloud were calculated in RiPROCESS software. 

 

3. For the final placement of the point cloud, it was 

aligned to the control points determined in the previous 

measurement phase, which serve as the reference 

framework for transformation into the S-JTSK 

coordinate system. A non-rigid trajectory method with 

local adjustment was applied for aligning the point 

cloud to the control points. 

 
 

Figure 6. Non-rigid trajectory with local adjustment 

 

The use of a multi-stage procedure (static and dynamic 

alignment, subsequent trajectory adjustment, and alignment to 

the control points) minimizes systematic errors and ensures the 

reliability of the results.  

All performed passes were conducted using the identical 

procedure. 

 

6. Data Processing Procedure 

All evaluations were performed using the open-source software 

CloudCompare, version 2.13.2 [1], which is widely used for the 

processing and analysis of 3D point clouds. This software enables 

comprehensive manipulation of point clouds, including cleaning, 

subsampling, smoothing, and comparison against reference 

surfaces. 

 

6.1 Data Preprocessing and Clearing 

A total of 10 point clouds were available, chronologically 

labelled 1 through 10. Of these, point clouds 1 - 5 and 8 were 

acquired under dry conditions, while the remaining 6, 7, 9, and 

10 were acquired on wet or partially wet roads. 

 

The first step involved the removal of unwanted objects from the 

point clouds, particularly stationary or moving vehicles that 

could distort the results. A combination of automatic software 

tools (specifically, Tools → Clean → Noise Filter) and manual 

inspection was used to ensure the removal of all artifacts that 

could affect subsequent evaluation. 

 

6.2 Subsampling and Data Density Normalisation 

The varying vehicle speed during data acquisition, including 

stops, resulted in an uneven point density. To achieve a 

homogeneous resolution, the Edit → Subsample function was 

applied, with a target distance of 3 mm between neighbouring 

points. Subsampling reduces data redundancy and improves the 

stability of subsequent deviation calculations. 
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6.3 Creating Reference Surfaces (Smoothing using MLS) 

To determine the dispersion of individual measurements, it was 

necessary to define the mean (most probable) surface shape. This 

can be obtained by local smoothing, fitting the point cloud with 

an appropriate mathematical surface using the least squares 

method applied to all suitable point clouds together. Smoothing 

was performed using the function available in CloudCompare via 

Plugins → PCL wrapper → Smooth using MLS. A second-order 

polynomial surface was used with a fitting surrounding of 0.04 

m, which preserves the local curvature of the surface. Since the 

measurement system produces higher-quality data when 

measuring a dry surface, the primary reference point cloud 

(hereafter DRY cloud) was defined as the average of data 

acquired under dry conditions. The secondary reference point 

cloud (WET cloud) was defined analogously from data acquired 

under wet conditions. Because these reference clouds were 

generated by merging multiple individual point clouds, their 

density is unnecessarily high; therefore, after smoothing, these 

reference datasets were also subsampled to a target distance of 3 

mm. 

 

6.4 TIN Reference Surface Transformation 

To obtain deviation sign for individual points, a triangular 

irregular network (TIN, mesh) was created from the reference 

point clouds. The TIN creation allows the surface composed of 

points to be approximated using triangles and is suitable for 

calculating distances from points to the surface. The function Edit 

→ Mesh → Delaunay 2.5D (best fitting plane) was used. 

 

6.5 Calculation of Deviations and Accuracy Characteristics 

The deviation values of individual points were determined as 

distances from the reference TIN surface using the function Tools 

→ Distances → Cloud → Mesh Dist. This step provides a set of 

deviations that characterize the differences between the measured 

point cloud and the reference surface. 

 

6.6 Individual Point Clouds Smoothening 

Individual point clouds were also smoothed separately because 

each dataset has a non-zero thickness/depth. 

 

 

7. Achieved Results 

The objective of the analysis was to evaluate the repeatability of 

MLS results and the influence of weather conditions (dry vs. wet) 

on the accuracy of mobile laser scanning. Individual point clouds 

were analysed and compared with reference models created from 

the benchmark datasets (DRY and WET). 

Statistical characteristics were calculated for each of the ten 

datasets. The results include the achieved values of mean 

deviation, residual standard deviation, and overall error (RMSE) 

for each pass. The results of the individual comparisons are 

presented in tables 3 - 9. 

 

The mean deviation represents the overall average deviation, 

characterizing possible systematic bias common to the entire 

point cloud, while the standard deviation represents the residual 

dispersion around this mean value. In addition, RMSE (Root 

Mean Square Error) was determined, describing the quadratic 

mean error characterizing the total error. 

 

𝑅𝑀𝑆𝐸 =  √1
𝑛

∑ 𝑑𝑖
2𝑛

𝑖=1    (1) 

where di is the deviation of the respective i-th point from the 

reference surface and n is the total number of points. RMSE 

provides a measure of the mean quadratic deviation. 

First, a comparison of the DRY and WET benchmark datasets 

was performed. 

 

mean deviation 

[m] 

standard 

deviation [m] 
RMSE [m] 

0,0004 0,0023 0,0023 

Table 3.  Reference comparison DRY and WET 

 

The results indicate that there practically is no systematic shift 

between the benchmark datasets. 

Next, a comparison of the dry passes against the dry benchmark 

was performed (using the clean data only). 

 

data 
mean 

deviation [m] 

standard 

deviation [m] 
RMSE [m] 

1 -0,0002 0,0032 0,0032 

2 -0,0005 0,0031 0,0031 

3 0,0004 0,0030 0,0030 

4 -0,0015 0,0040 0,0043 

5 -0,0003 0,0045 0,0045 

8 0,0027 0,0036 0,0045 

mean 0,0001 0,0036 0,0038 

Table 4.  Reference DRY – Clean DRY data  

 

The clean point clouds were then smoothed, and the results are 

presented in the following table. 

 

data 
mean 

deviation [m] 

standard 

deviation [m] 
RMSE [m] 

1 -0,0002 0,0015 0,0015 

2 -0,0005 0,0016 0,0017 

3 0,0004 0,0014 0,0015 

4 -0,0015 0,0028 0,0032 

5 -0,0003 0,0030 0,0030 

8 0,0027 0,0021 0,0034 

mean 0,0001 0,0022 0,0025 

Table 5.  Reference DRY – Smooth DRY data  

 

The same analyses were then performed for the individual wet 

passes, compared against the DRY reference. 

 

data 
mean 

deviation [m] 

standard 

deviation [m] 
RMSE [m] 

6 -0,0002 0,0049 0,0049 

7 0,0007 0,0040 0,0041 

9 0,0016 0,0047 0,0050 

10 -0,0008 0,0052 0,0053 

mean 0,0003 0,0047 0,0048 

Table 6.  Reference DRY – Clean WET data 
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data 
mean 

deviation [m] 

standard 

deviation [m] 
RMSE [m] 

6 -0,0002 0,0034 0,0034 

7 0,0007 0,0020 0,0021 

9 0,0016 0,0030 0,0034 

10 -0,0008 0,0043 0,0044 

mean 0,0003 0,0033 0,0034 

Table 7.  Reference DRY – Smooth WET data  

 

The results indicate that the wet passes show approximately 1 

mm worse performance relative to the dry benchmark. 

Next, a comparison of the wet passes against the WET 

benchmark was performed. 

 

data 
mean 

deviation [m] 

standard 

deviation [m] 
RMSE [m] 

6 -0,0006 0,0041 0,0041 

7 0,0002 0,0038 0,0038 

9 0,0012 0,0058 0,0059 

10 0,0011 0,0040 0,0041 

mean 0,0005 0,0045 0,0046 

Table 8.  Reference WET – Clean WET data  

 

data 
mean 

deviation [m] 

standard 

deviation [m] 
RMSE [m] 

6 -0,0006 0,0019 0,0020 

7 0,0002 0,0016 0,0016 

9 0,0011 0,0023 0,0025 

10 0,0011 0,0027 0,0029 

mean 0,0005 0,0022 0,0023 

Table 9.  Reference WET – Smooth WET data  

 

The results indicate the following: 

Comparison of the reference datasets DRY x WET: the overall 

elevation shows practically no systematic difference - 0.4 mm. 

The overall data dispersion on the wet surface is higher - dry 

RMSE: 3.8 mm (clean) and 2.5 mm (smooth); wet RMSE: 4.8 

mm (clean) and 3.4 mm (smooth). Analysis of the wet passes 

shows that problematic areas occur in locations where a thicker 

layer of water was present during the pass, resulting in very high 

surface dispersion (e.g. 20 cm). In some cases, the underlying 

surface is captured beneath this noise. In other cases it is not, and 

after noise removal, holes appear in the point cloud. This 

phenomenon can be observed at figure 7 left (noise) and right 

(holes). 

In the hypsometric model shown on figure 8, the problematic 

areas with higher water occurrence are visible. This corresponds 

to the DRY benchmark versus wet pass no. 9. 

Figure 7. Local cloud disturbances (wet pass no. 9) 

 
Figure 8. Hypsometric representation of deviations (wet pass 

no. 9) 

 

In the figure 9 is detail showing the ruts in the asphalt of the road 

from heavy traffic where the water level is higher (in red). 
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Figure 9. Hypsometric representation of deviations (wet pass no. 

9) – detail  

 
Figure 10. Hypsometric representation of deviations (dry pass 1) 

For comparison, one can look at figure 10, where dry pass 1 

deviations is also shown hypsometrically. It is worth noting the 

scale range, which is only ± 4.5 mm here. 

 

8. Conclusion 

The achieved results indicate that by following an identical data 

acquisition and processing procedure, it is possible to achieve 

results with a standard deviation better than 3 mm and practically 

no systematic influence. Furthermore, the effect of a wet surface 

is also evident; in addition to increased value dispersion, 

pronounced local disturbances also occur. From the RMS and 

standard deviation results, compliance with the accuracy 

specified by the manufacturer is apparent. 
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